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Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s
UMA Discrete UMA Discrete
Product Name HP ProBook 4320s Notebook PC v v
NOTE: Discrete not for use in the People's
Republic of China.
HP ProBook 4321s Notebook PC v
NOTE: For use in the People's Republic of
China.
HP ProBook 4420s Notebook PC 3 J
HP ProBook 4421s Notebook PC \
Processors Intel® Arrandale™
e i7-620M, 2.66-GHz (Turbo up to 3.33 GHz), \ \ \ J
4-MB L3 cache, 4 threads
e i5-540M, 2.53-GHz (Turbo up to 3.06 GHz), \ \ \ J
3-MB L3 cache, 4 threads
e i5-520M, 2.4-GHz (Turbo up to 2.93 GHz), 3- v v v R
MB L3 cache, 4 threads
e  5-430M, 2.26-GHz (Turbo up to 2.53 GHz), v v v v
3-MB L3 cache, 4 threads
e  i3-330M, 2.13-GHz, 3-MB L3 cache, 4 v y v J
threads (35 W)
e i3-350M, 2.26-GHz, 3-MB L3 cache, 4 3 3 3 J
threads (35 W)
Chipsets Intel® HM57 Express v v v R
Graphics Intel® HD Graphics v v
Universal Memory Architecture (UMA) graphics
subsystem integrated with shared video memory
(dynamically allocated)
ATI Mobility Radeon™ HD 4350 v \/
AMD discrete graphics ATI-M93S3-LP with
Hypermemory support; 512-MB DDR3, 800 MHz
Panels All display panel assemblies support privacy filter v v v R
LED backlight v v v R
e  33.8-cm (13.3-in) HD (1366x768 resolution) y y




Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s

UMA Discrete UMA Discrete

e  33.8-cm (13.3-in) HD BrightView J «/
e  33.8-cm (13.3-in) HD with webcam J J
e  33.8-cm (13.3-in) HD with webcam for use \/
with WWAN
e  33.8-cm (13.3-in) HD BrightView with J «/
webcam
e  33.8-cm (13.3-in) HD BrightView with \/
webcam and WWAN
e  35.6-cm (14.0-in) HD (1366x768 resolution) v \/
e  35.6-cm (14.0-in) HD BrightView v y
e  35.6-cm (14.0-in) HD with webcam V v
e  35.6-cm (14.0-in) HD BrightView with \ v
webcam
Memory 2 customer-accessible/upgradable SODIMM \/ \/ \/ v
memory module slots
Supports dual-channel memory N N N N
Supports up to 4 GB of system memory in Brazil N N
Supports up to 8 GB of system memory in all \/ \/ \/ v
countries and regions except Brazil
PC3-10600, 1333-MHz, DDR3 J J J v
Supports the following configuration in all \/ \/ \ v

countries and regions except Brazil:

e  8192-MB total system memory (4096-MB x
2, dual-channel)

e  4096-MB total system memory (4096-MB x
1)

e  4096-MB total system memory (2048-MB x
2, dual channel)

e  3072-MB total system memory (2048-MB +
1024-MB, dual channel)

e  2048-MB total system memory (2048-MB x
1)

e  2048-MB total system memory (1024-MB x
2, dual channel)

e  1024-MB total system memory (1024-MB x
1)

2 Chapter 1 Product description



Category

Description

HP
ProBook
4320s

HP

ProBook4 ProBook

320s /
4321s

HP

4420s

HP
ProBook
4421s

UMA

Discrete

UMA

Discrete

Supports the following configurations in Brazil:

e  4096-MB total system memory (2048-MB x
2, dual-channel)

e  3072-MB total system memory (2048-MB +
1024-MB, dual channel)

e  2048-MB total system memory (2048-MB x
1)

\/

\/

\/

Hard drives

Supports 9.5-mm, 6.35-cm (2.50-in) hard drives

Customer-accessible

Serial ATA

Supports the following drives:
° 500-GB, 7200-rpm
e  320-GB, 7200-rpm
e  250-GB, 7200-rpm

< | 2| 2| <

< | 2| 2| <

< | 2| 2| <

< | < | < | <2

HP 3D DriveGuard (not available on Linux)

Optical drives

Fixed

12.7-mm (0.50-in) tray load

Supports option of no optical drive

< | 2| 2| <2

< | 2| 2| 2

< | 2| 2| <2

< | 2| 2| 2

Supports the following drives:

e  Blu-ray ROM with LightScribe DVD+R/RW
SuperMulti DL Drive

NOTE: Not available with UMA base model and
Window XP.

e DVD*RW SuperMulti Double-Layer Drive
with LightScribe

e DVD ROM Drive

Diskette drive

Supports external USB diskette drive only

Audio/Visual

HD audio - IDT 92HD80

Integrated microphone

Two stereo speakers

Integrated 2.0-megapixel webcam (fixed focus)

Modem

High-speed 56k modem for all regions and
countries except Brazil

2 | 2| 2| 2| 2| 2| <

2| 2| 2| 2| 2| 2| <

2| 2| 2| 2| 2| 2| <

< | 2| 2| 2| 2| 2| <

High-speed 56k modem for use in Brazil

2

2

Modem cable not included




Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s
UMA Discrete UMA Discrete
Supports no modem option N N N N
Ethernet 10/100/1000 Ethernet network interface card (NIC) \ \/ \/ N
S3/S4/S5 wake on LAN (AC only mode) N \/ N N
Wireless Integrated WLAN options by way of wireless module:
Support for the following WLAN formats: \/ \/ \/ v
e Broadcom 802.11a/b/g/n 2x2
e Broadcom 802.11b/g
e  Atheros 802.11b/g/n 1x1
e Realtek 802.11b/g/n 1x1
e Intel Advanced-N 6200 802.11a/b/g/n 2x2
e Intel Advanced-N 6200 802.11a/b/g 1x2
e Intel Wireless-N 1000 802.11b/g/n 1x2
e Intel Wireless-N 1000 802.11b/g 1x2
2 WLAN antennas built into display assembly N \ \/ N
Support for no-WLAN option N N N N
Integrated personal area network (PAN) options by way of Bluetooth® module:
Support for no-WPAN option \/ \/ \/ \/
Broadcom Bluetooth 2.1 + EDR J V V v
Integrated WWAN options by way of WWAN module:
WWAN module UNDP with 2 antennas (not N
available with Linux)
Two five-band WWAN antennas built into display \/
assembly
Subscriber identity module (SIM) security \/
(customer-accessible in battery bay)
External media One ExpressCard slot (34 mm) \/ S S N
cards
Media Card Reader supporting Memory Stick \/ \ N N
(MS), Memory Stick Pro (MSP), Secure Digital
(SD) Memory Card, Secure Digital High Capacity
(SDHC) Memory Card, MultiMediaCard (MMC),
and xD-Picture Card formats
Ports Audio-in (stereo microphone) \/ \/ \/ v
Audio-out (stereo headphone) \/ \/ \/ \/
RJ-11 (modem) v v J \/
RJ-45 (Ethernet, includes link and activity lights) v v N N
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Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s
UMA Discrete UMA Discrete
USB 2.0 (3) v v v \
Combo eSATA/USB 2.0 (1) v v v S
HDMI v v v v
VGA (Dsub 15-pin) supporting 1600 x 1200 v v v ol
external resolution at 75-GHz (hot plug/unplug
with auto-detect)
Multi-pin AC power v v v \
Keyboard and 33.8-cm (13.3-in) keyboard with TouchPad v v
pointing devices
35.6-cm (14.0-in) keyboard with TouchPad v <
TouchPad only, with 2 TouchPad buttons and v v v S
vertical scrolling (taps enabled as default)
Power 65-W AC adapter with localized cable plug support v v
requirements (3-wire plug with ground pin)
90-W AC adapter with localized cable plug support v \
(3-wire plug with ground pin)
9-cell, 93-Wh Li-ion battery v v v \
6-cell, 47-Wh Li-ion battery v v v \
Security Supports Kensington security lock v v v \
Intel AT support v v v N
Operating Preinstalled:
system
NOTE: Windows Vista® includes SP1 and
Windows® XP Pro includes SP3 (Ver 2 1)
Windows 7 Professional 32 (with Windows XP v v v \
Professional images) with MS Basics (Japan only)
Windows 7 Professional 32 with MS Basics v v v \
(Japan only)
Windows 7 Home Premium 32 with MS Basics \ \ \ J
(Japan only)
Windows Vista Business 32 with MS Basics y y y J
(Japan only)
Windows Vista Home Basic 32 with MS Basics v v v \
(Japan only)
FreeDOS v v v <
RedFlag Linux (People's Republic of China only) v v v \
SUSE Linux (SLED11) v v v \

Preinstalled with Office:




Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s

UMA Discrete UMA Discrete

Windows 7 Starter with Office 2007 Ready S «/ «/ N
(excludes Japan)

Windows 7 Starter with Office 2007 Ready - EDGI \/ N N N
(available for Argentina, Brazil - English, Brazil,

Latin America, Latin America - English, Russia,

India, Asia Pacific, Thailand)

Windows 7 Home Basic 32 with Office 2007 «/ «/ N N
Ready (excludes Japan)

Windows 7 Home Basic with Office 2007 Ready - \ N \/ v
EDGI (available for Argentina, Brazil - English,

Brazil, Latin America, Latin America - English,

Russia, People's Republic of China, India, Asia

Pacific, Thailand)

Windows 7 Home Premium 32 with Office 2007 \ \ \ \/
Ready (excludes Japan)

Windows 7 Home Premium with Office 2007 N N N N
Ready - EDGI (available for Argentina, Brazil -

English, Brazil, Latin America, Latin America -

English, Russia, People's Republic of China, Hong

Kong, India, Asia Pacific, Thailand)

Windows 7 Home Premium 32 with Office 2007 \/ N \/ N
Personal (Japan only)

Windows 7 Home Premium 32 with Office 2007 \/ \/ \/ v
Personal with PowerPoint (Japan only)

Windows 7 Home Premium 32 with Office 2007 \ \ \ \
Professional (Japan only)

Windows 7 Professional 32 with Office 2007 S S \ N
Ready (excludes Japan)

Windows 7 Professional with Office 2007 Ready - S \/ \/ N
EDGI (available for Argentina, Brazil - English,

Brazil, Latin America, Latin America - English,

Russia, People's Republic of China, Hong Kong,

India, Asia Pacific, Thailand)

Windows 7 Professional 32 with Office 2007 \ N N N
Personal (Japan only)

Windows Vista® Professional 32 with Office 2007 v v v v
Personal with PowerPoint (Japan only)

Windows 7 Professional 32 with Office 2007 N N N N
Professional (Japan only)

Windows 7 Professional (with Windows XP \/ S \/ N
Professional images) with Office 2007 Ready
(excludes Japan)

6 Chapter 1 Product description



Category

Description HP
ProBook
4320s

HP

ProBook4 ProBook

320s /
4321s

HP

4420s

HP
ProBook
4421s

UMA

Discrete

UMA

Discrete

Windows 7 Professional (with Windows XP
Professional images) with Office 2007 Ready -
EDGI (available for Argentina, Brazil - English,
Brazil, Latin America, Latin America - English,
Russia, People's Republic of China, Hong Kong,
India, Asia Pacific, Thailand)

\/

\/

Windows 7 Professional (with Windows XP v
Professional images) with Office 2007 Personal
(Japan only)

Windows 7 Professional (with Windows XP v
Professional images) with Office 2007 Personal
with PowerPoint (Japan only)

Windows 7 Professional (with Windows XP v
Professional images) with Office 2007
Professional (Japan only)

Windows Vista Home Basic 32 with Office 2007 v
Ready (excludes Japan)

Windows Vista Home Basic 32 with Office 2007 v
Personal (Japan only)

Windows Vista Home Basic 32 with Office 2007 v
Personal with PowerPoint (Japan only)

Windows Vista Home Basic 32 with Office 2007 v
Professional (Japan only)

Windows Vista Business 32 with Office 2007 v
Ready (excludes Japan)

Windows Vista Business 32 with Office 2007 v
Personal (Japan only)

Windows Vista Business 32 with Office 2007 v
Personal (Japan only)

Windows Vista Business 32 with Office v
Professional (Japan only)

Restore media:

Windows 7 Professional 64

Windows 7 Professional 32

Windows 7 Home Premium 32

Windows 7 Home Basic 32

Windows 7 Starter

Windows Vista Business 32

Windows Vista Home Basic 32

2| 2| 2| 2| 2| 2| 2| <

Windows XP Professional

2| 2| 2| 2| 2| 2| 2| <

2| 2| 2| 2| 2| 2| 2| <

P N D e i I
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Category Description HP HP HP HP
ProBook ProBook4 ProBook ProBook
4320s 320s / 4420s 4421s
4321s
UMA Discrete UMA Discrete

Microsoft Office Ready DVD \ \ N N
DRDVD Windows 7 Home Premium/Windows 7 J J \/ y
Professional
DRDVD Windows 7 Starter/Windows 7 Home v v v v
Basic
DRDVD Windows XP Professional v v v v
DRDVD Windows Vista v v v v
Red Flag Linux (in the People's Republic of China N N N N
only)
SUSE Linux J V J v
Certified: Microsoft® WHQL V V V 3
Web Support:
Windows 7 Professional 64 \/ \/ \/ v
Windows Vista Business 64 V V V y

Serviceability End-user replaceable parts:
AC adapter N N N N
Battery (system) \/ N \/ v
Bluetooth module J \/ \/ y
Keyboard \/ \/ \/ N
Speaker assembly \/ \/ \/ \/
Hard drive \/ J J \/
Memory module \ \/ J \/
Optical drive N N N v
WLAN module v v v v
WWAN module v v v v
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2 External component identification

Identifying hardware

Components included with the computer may vary by region and model. The illustrations in this
chapter identify the standard features on most computer models.

Bf NOTE: Your computer may look slightly different from the illustrations in this section.

Use the following instructions to see a list of hardware installed in the computer.

In Windows® 7:
A Select Start > Control Panel > System and Security > Device Manager.

You can also add hardware or modify device configurations using Device Manager.

Bf NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

In Windows Vista®:
1. Select Start > Computer > System Properties.
2. Inthe left pane, click Device Manager.

You can also add hardware or modify device configurations using Device Manager.

B NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

In Windows XP:
1. Select Start > My Computer.
2. Inthe left pane of the System Tasks window, select View system information.
3. Select Hardware tab > Device Manager.

You can also add hardware or modify device configurations using Device Manager.

Identifying hardware



Top components
TouchPad

Component

Description

1) TouchPad off indicator

To turn the TouchPad zone on and off, quickly double-tap the
TouchPad off indicator.

NOTE: When the TouchPad zone is active, the light is off.

(2) TouchPad zone*

Moves the pointer and selects or activates items on the screen.

3) Left TouchPad button*

Functions like the left button on an external mouse.

(4) Right TouchPad button*

Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >

Printers and Other Hardware > Mouse.

10 Chapter 2 External component identification



Lights

Component

Description

(1

TouchPad off indicator

Amber: The TouchPad is off.
Off: The TouchPad is on.

(2) Caps lock light On: Caps lock is on.
(3) HP QuickLook light Blinking: QuickLook is being opened or closed.
(4) HP QuickWeb light Blinking: The Web browser is being opened or closed.
(5) Power light e  On: The computer is on.
e  Blinking: The computer is in Standby.
e  Off: The computer is off or in Hibernation.
(6) Wireless light e  White: An integrated wireless device, such as a wireless

local area network (WLAN) device and/or a Bluetooth®
device, is on.

Amber: All wireless devices are off.

Top components
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Buttons, speakers, switches, and fingerprint reader (select models only)

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

1) Speakers (2)

Produce sound.

(2) Internal display switch

Turns off the display if the display is closed while the power is on.

(3) Power button

e  When the computer is off, press the button to turn on the
computer.

e  When the computer is on, press the button to shut down the
computer.

e  When the computer is in Standby, press the button briefly to
exit Standby.

e  When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings and how to change
them, select Start > Control Panel > Performance and
Maintenance > Power Options.

(4) Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a password
logon.
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Component

Description

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the cursor.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad when

pressed in combination with the fn and num Ik keys.

(6)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

Top components
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Front components

e o
® OO

Component

Description

1) Drive light

e  Blinking white: The hard drive or optical drive is being
accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2) Media Card Reader

Supports the following optional digital card formats:
e  Memory Stick

e  Memory Stick Duo (adapter required)

e  Memory Stick Pro (adapter required)

e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

e  xD-Picture Card (XD) Type M

(3) Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

14 Chapter 2 External component identification



Right-side components

Component

Description

()

USB ports (2)

Connect optional USB devices.

()

RJ-11 (modem) jack (select models only)

Connects a modem cable.

(©)

Optical drive light (select models only)

Blinking: The optical drive is being accessed.

(4)

Optical drive (select models only)

Reads optical discs and, on select models, also writes to optical
discs.

Right-side components

15



Left-side components

®®

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) Power connector Connects an AC adapter.

(3) AC adapter light e  On: The computer is connected to external power and the
battery is charging.

e  Off: The computer is not connected to external power.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) RJ-45 (network) jack Connects a network cable.

(7) HDMI port Connects an optional HDMI device.

(8) Combo eSATA/USB port Connects an optional USB device or high-performance eSATA
components, such as an eSATA external hard drive.

9) USB port Connects optional USB device.

(10) ExpressCard slot Supports optional ExpressCards.

16 Chapter 2 External component identification



Bottom components

@ O
v

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM

slot is located inside the battery bay.

Bottom components 17



Display

B NOTE: Your computer may look slightly different from the illustration in this section.

®

9

Component

Description

(1)

Internal display switch

Turns off the display if the display is closed while the power is on.

)

Internal microphone

Records sound.

(3)

Webcam light (select models only)

On: The webcam is in use.

4

Webcam (select models only)

Records video and captures still photographs.

18 Chapter 2 External component identification



Wireless antennas (select models only)

The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component Description

(1) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless
wide area networks (WWANS).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLANS).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennas (select models only) 19



Additional hardware components
ui

Component Description
(1) Power cord* Connects an AC adapter to an AC outlet.
(2) Battery* Powers the computer when the computer is not plugged into an

external power source.

3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.

20 Chapter 2 External component identification



3 lllustrated parts catalog

Serial number label location

When ordering parts or requesting information, the serial number label, located on the bottom of the
computer, provides important information that you may need when contacting technical support.

(1) Product name (4) Warranty period

(2) Serial number (5) Model description (select models)

(3) Product number

A0 300K
RN AT
o LR TRAE BT

Serial number label location
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Item

Description

Spare part number

()

Display assembly (includes 2 WLAN antennas and cables and, on select computer models, 2 WWAN antennas

and cables)

NOTE: WWAN is available only on select models with 33.8-cm 13.3-in displays.

e 33.8-cm (13.3-in) HD (1366x768 resolution) 599553-001
e  33.8-cm (13.3-in) HD BrightView 599554-001
e  33.8-cm (13.3-in) HD BrightView with webcam 599555-001
e  33.8-cm (13.3-in) HD BrightView with webcam and WWAN 599556-001
e  33.8-cm (13.3-in) HD with webcam 599557-001
e  33.8-cm (13.3-in) HD with webcam and WWAN 599558-001
e 33.8-cm (13.3-in) HD (1366x768 resolution) , red 608736-001
e  33.8-cm (13.3-in) HD BrightView, red 608737-001
e  33.8-cm (13.3-in) HD BrightView with webcam, red 608738-001
e  33.8-cm (13.3-in) HD with webcam, red 608739-001
e 35.6-cm (14.0-in) HD (1366x768 resolution) 599559-001
e  35.6-cm (14.0-in) HD BrightView 599560-001
e 35.6-cm (14.0-in) HD BrightView with webcam 599561-001
e  35.6-cm (14.0-in) HD with webcam 599562-001
e  35.6-cm (14.0-in) HD (1366x768 resolution), red 608740-001
e  35.6-cm (14.0-in) HD BrightView, red 608741-001
e  35.6-cm (14.0-in) HD BrightView with webcam, red 608742-001
e  35.6-cm (14.0-in) HD with webcam, red 608743-001

(2) Switch cover (includes power button board)
e  For with 33.8-cm (13.3-in) displays 599567-001
e  For with 33.8-cm (13.3-in) displays, red 607652-001
e  For with 35.6-cm (14.0-in) displays 599568-001
e  For with 35.6-cm (14.0-in) displays, red 607653-001

(3) Power button board (included with switch cover)

(4) Keyboard
In computer models with 33.8-cm (13.3-in) displays:
e  For use in Belgium 599572-A41
e Foruse in Brazil 599572-201
e  For use in Bulgaria 599572-261
e  Foruse in Canada (French) 599572-121
e  Forusein Denmark 599572-081
e  Forusein Europe 599572-B31

Computer major components
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Item Description

Spare part number

e Forusein France 599572-051

e  For use in French Arabic region 599572-DW1
e  Foruse in Germany 599572-041

e Forusein Greece 599572-DJ1

e  Foruse in Hungary 599572-211

e Forusein Iceland 599572-DD1
e Forusein Israel 599572-BB1
e Forusein Italy 599572-061

e Foruse in Japan 599572-291

e Foruse in Korea 599572-AD1
e  Foruse in Latin America 599572-161

e  Foruse in Norway 599572-091

e  For use in Portugal 599572-131

e  Foruse in Russia 599572-251

e  For use in Saudi Arabia 599572-171

e  Foruse in Spain 599572-071

e  Foruse in Sweden and Finland 599572-B71

e  For use in Switzerland 599572-BG1
e Forusein Taiwan 599572-AB1

e Forusein Thailand 599572-281

e  For use in the Adriatic region 599572-BA1

e  For use in the Czech Republic and Slovakia 599572-A81

e  For use in the United Kingdom 599572-031

e Foruse in the United States 599572-001

e  Foruse in Turkey 599572-141

In computer models with 35.6-cm (14.0-in) displays:

e  For use in Belgium 599573-A41

e  For use in Brazil 599573-201

e  Foruse in Bulgaria 599573-261

e  Foruse in Canada (French) 599573-121

e  Forusein Denmark 599573-081

e For use in Europe 599573-B31

e Forusein France 599573-051

e  Foruse in French Arabic region 599573-DW1
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Item Description Spare part number
e  Foruse in Germany 599573-041
e Forusein Greece 599573-DJ1
e  For use in Hungary 599573-211
e Forusein Iceland 599573-DD1
e Forusein Israel 599573-BB1
e Forusein ltaly 599573-061
e Forusein Japan 599573-291
e Forusein Korea 599573-AD1
e  Foruse in Latin America 599573-161
e  Foruse in Norway 599573-091
e  Foruse in Portugal 599573-131
e Forusein Russia 599573-251
e  Foruse in Saudi Arabia 599573-171
e  Forusein Spain 599573-071
e Foruse in Sweden and Finland 599573-B71
e  For use in Switzerland 599573-BG1
e Forusein Taiwan 599573-AB1
e Forusein Thailand 599573-281
e  Foruse in the Adriatic region 599573-BA1
e  For use in the Czech Republic and Slovakia 599573-A81
e  Foruse in the United Kingdom 599573-031
e Foruse in the United States 599573-001
e  Forusein Turkey 599573-141

(5) Palm rest (includes TouchPad)
e  For use with fingerprint reader and 33.8-cm (13.3-in) displays 599549-001
e  For use with 33.8-cm (13.3-in) displays 599551-001
e  For use with fingerprint reader and 33.8-cm (13.3-in) displays, red 607648-001
e  Foruse with 33.8-cm (13.3-in) displays, red 607650-001
e  For use with fingerprint reader and 35.6-cm (14.0-in) displays 599550-001
e  For use with 35.6-cm (14.0-in) displays 599552-001
e  For use with fingerprint reader and 35.6-cm (14.0-in) displays, red 607649-001
e  For use with 35.6-cm (14.0-in) displays, red 607651-001

(6) Top heat shield/bracket (included with top cover)

(7) Fan 599544-001

Computer major components
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Item Description Spare part number
(8) Processor heat sink

For use with discrete graphics subsystems 599653-001

For use with Unified Memory Architecture (UMA) graphics subsystems 599546-001
9) Memory module (PC3-10600, 1333-MHz, DDR3, shared)

2048-MB 598856-002

1024-MB 598859-002
(10) Bluetooth module cable (included in Cable kit on page 32, part number 599525-001)
(11) Bluetooth module (without cable) 537921-001
(12) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The

modem module cable is included in the Cable kit. See Cable kit on page 32 for more

Cable Kit spare part information.

High-speed 56K modem for use in all countries and regions except Australia and New 510100-001

Zealand

High-speed 56K modem for use in Australia and New Zealand 510100-011
(13) WLAN module

Intel® Centrino™ Advanced-N 6200 802.11a/b/g 2x2

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, 572510-001

Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,

Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech

Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,

France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam,

Guatemala, Haiti, Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,

Ireland, Israel, Italy, the lvory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan,

Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,

Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the

Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the

People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar,

Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South

Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and

Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin

Islands, the United States, Venezuela, and Vietham

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, 572520-001

Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam,
Guatemala, Haiti, Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan,
Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the
People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar,
Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South
Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin
Islands, the United States, Venezuela, and Vietham
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Item

Description Spare part number

Intel Centrino Wireless-N 1000 802.11b/g 1x2 for use in Russia and Ukraine 585984-001

Intel WiFi Link 6200 802.11a/g/n

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, 572509-001
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam,
Guatemala, Haiti, Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, Italy, the lvory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan,
Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the
People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar,
Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South
Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin
Islands, the United States, Venezuela, and Vietham

Broadcom 4312G 802.11b/g WiFi Adapter

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the 504593-003
U.S. Virgin Islands

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 504593-004
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and
the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan,
Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001

(14

WWAN module, Qualcomm EV-DO HSPA 531993-001

(15)

RTC battery 599516-001

(16)

Top cover

For use with 33.8-cm (13.3-in) displays 599569-001

For use with 35.6-cm (14.0-in) displays 599570-001

(7

Processor (includes replacement thermal material)

Computer major components
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Item Description Spare part number
e Intel® Arrandale™ 520M 2.4-GHz 594187-001
e Intel Arrandale 540M 2.53-GHz 594188-001
e Intel Arrandale Core 620M 2.26-GHz 587259-001
e Intel Arrandale i3-330M 2.13-GHz 597622-001
e Intel Arrandale i3-350M 2.26-GHz 597623-001
e Intel Arrandale i5-430M 2.26-GHz 597624-001
(18) System board (includes replacement thermal material)
e  For use with Unified Memory Architecture (UMA) graphics subsystem, WWAN module, 599521-001
and 33.8-cm (13.3-in) displays
e  For use with UMA graphics subsystem and 33.8-cm (13.3-in) displays 599520-001
e  For use with discrete graphics subsystem and 33.8-cm (13.3-in) displays 599518-001
e  For use with UMA graphics subsystem and 35.6-cm (14.0-in) displays 599523-001
e  For use with discrete graphics subsystem and 35.6-cm (14.0-in) displays 599522-001
e  For use with UMA graphics subsystem and 35.6-cm (14.0-in) displays in the People's 608267-001
Republic of China and Russia
e  For use with discrete graphics subsystem and 35.6-cm (14.0-in) displays in the 608266-001
People's Republic of China and Russia
(19) Power connector with cable 599517-001
(20) RJ11 (modem) cable (see Cable kit)
(21) Speakers
e  For use with 33.8-cm (13.3-in) displays 599566-001
e  For use with 35.6-cm (14.0-in) displays 605559-001
(22) USB connector board and cable 599524-001
(23) ExpressCard slot bezel (included in Plastics kit, see Plastics Kit on page 31)
(24) Base enclosure
For use in computer models with 33.8-cm (13.3-in) displays 535864-001
For use in computer models with 35.6-cm (14.0-in) displays 599515-001
(25) Battery
9-cell, 93-Wh (2.8Ah) Li-ion 593573-001
6-cell, 47-Wh (2.2Ah) Li-ion 593572-001
(26) Hard drive (includes hard drive bracket)
500-GB, 7200-rpm 599543-001
320-GB, 7200-rpm 599542-001
250-GB, 7200-rpm 599541-001
(27) SIM (provided by your wireless vendor for use with WWAN option)
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Item Description Spare part number
(28) Optical drive (includes bezel)
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 599538-001
DVD+RW SuperMulti Double-Layer Drive with LightScribe 599540-001
DVD ROM Drive 599539-001

Display assembly components
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Item  Description Spare part number
1) Display bezel
e  For 33.8-cm (13.3-in) displays with webcam 536421-001
e  For 35.6-cm (14.0-in) displays with webcam 536424-001
e  For 33.8-cm (13.3-in) displays without webcam 536423-001
e  For 35.6-cm (14.0-in) displays without webcam 536422-001
(2) Webcam module 599571-001
3) Display panel (included with display assembly; see Computer major components
on page 22)
(4) Display hinge kit
e Display hinge and panel bracket (left and right) for 33.8-cm (13.3-in) displays 599536-001
e Display hinge and panel bracket (left and right) for 35.6-cm (14.0-in) displays 599537-001
(5) Display cable (includes microphone and, on select models, webcam connector)
e Display cable for 33.8-cm (13.3-in) displays with webcam 599534-001
e Display cable for 35.6-cm (14.0-in) displays with webcam 605558-001
o Display cable for 33.8-cm (13.3-in) displays without webcam 605557-001
o Display cable for 35.6-cm (14.0-in) displays without webcam 599535-001
(6) WLAN antennas and cables (included with back cover)
(7) WWAN antennas and cables (included with back covers used with WWAN option)
(8) Display back cover
e  For 33.8-cm (13.3-in) displays without WWAN 599526-001
e  For 35.6-cm (14.0-in) displays without WWAN 599527-001
e  For 33.8-cm (13.3-in) displays with WWAN 599528-001
e For 35.6-cm (14.0-in) displays with webcam and without WWAN 605556-001
e  For 33.8-cm (13.3-in) displays with webcam and without WWAN 607094-001
e For 33.8-cm (13.3-in) displays without WWAN, red 607643-001
e  For 33.8-cm (13.3-in) displays with webcam and without WWAN, red 607644-001
e  For 33.8-cm (14.0-in) displays without WWAN, red 607645-001
e  For 35.6-cm (14.0-in) displays with webcam and without WWAN, red 607646-001
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Plastics Kit
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Item  Description Spare part number
Plastics Kit: 599563-001
(1) ExpressCard slot bezel

(2) Optical drive blank (used with no ODD option)

RJ11 (modem) connector blank (not illustrated, used with No-Modem option)
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Cable kit
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Item Description Spare part number
Cable kit: 599525-001
(1) Power cable

(2) Bluetooth cable

3) RJ-11 (modem) jack cable
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Mass storage devices
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Item  Description Spare part number

(1) Hard drive (includes bracket)
500-GB, 7200-rpm 599543-001
320-GB, 7200-rpm 599542-001
250-GB, 7200-rpm 599541-001

(2) Optical drive (includes bezel)
Blu-ray Disc ROM Drive with SuperMulti DVD +R/RW Double-Layer 599538-001
DVD+RW SuperMulti Double-Layer Drive with LightScribe 599540-001
DVD-ROM Drive 599539-001

Mass storage devices
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Miscellaneous parts

Description Spare part number

AC adapters

65-W, 3-pin Smart AC adapter

e  For use in all countries and regions except India 463958-001

° For use in India 577170-001

90-W Slimline AC adapter

e  For use in all countries and regions except India 463955-001

e Forusein India 535593-001

Power cords (AC power, 3-pin, black, 1.83 m)

e  Foruse in Argentina 490371-D01
e  Foruse in Austria 490371-011
e  Foruse in Brazil 490371-202
e  Foruse in Denmark 490371-081
e Forusein Europe 490371-021
e Forusein India 490371-D61
e Forusein Israel 490371-BB1
e Forusein ltaly 490371-061
e Forusein Japan 490371-291
e  Foruse in North America 490371-001
e Foruse in the People's Republic of China 490371-AA1
e  For use in South Africa 490371-AR1
e  Forusein South Korea 490371-AD1
e  Foruse in Switzerland 490371-111
e Forusein Taiwan 490371-AB1
e  For use in the United Kingdom and Singapore 490371-031

34 Chapter 3 lllustrated parts catalog



Description

Spare part number

Rubber kit (includes display bumpers, display screw covers, base enclosure feet, and display 599564-001
hinge bumpers)
Screw kit, includes: 599565-001

T8 slotted-torx M2.5x6.5
T8 slotted-torx M2.5x5.0
T8 slotted-torx M2.5x3.0
Phillips P1 M2.5x5.0
Phillips P1 M2.5x3.0
Phillips P1 M2.0x3.0
Phillips PO M2.0x2.5
Phillips M3.0x3.5

Miscellaneous parts
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Sequential part number listing

Spare part Description

number

463955-001 90-W Slimline AC adapter for use in all countries and regions except India
463958-001 65-W, 3-pin Smart AC adapter for use in all countries and regions except India
490371-001 Power cord (AC power, 3-pin, black, 1.83 m), for use in North America
490371-011 Power cord (AC power, 3-pin, black, 1.83 m), for use in Austria

490371-021 Power cord (AC power, 3-pin, black, 1.83 m), for use in Europe

490371-031 Power cord (AC power, 3-pin, black, 1.83 m), for use in the United Kingdom and Singapore
490371-061 Power cord (AC power, 3-pin, black, 1.83 m), for use in Italy

490371-081 Power cord (AC power, 3-pin, black, 1.83 m), for use in Denmark

490371-111 Power cord (AC power, 3-pin, black, 1.83 m), for use in Switzerland
490371-202 Power cord (AC power, 3-pin, black, 1.83 m), for use in Brazil

490371-291 Power cord (AC power, 3-pin, black, 1.83 m), for use in Japan

490371-AA1 Power cord (AC power, 3-pin, black, 1.83 m), for use in the People's Republic of China

490371-AB1 Power cord (AC power, 3-pin, black, 1.83 m), for use in Taiwan

490371-AD1 Power cord (AC power, 3-pin, black, 1.83 m), for use in South Korea

490371-AR1 Power cord (AC power, 3-pin, black, 1.83 m), for use in South Africa

490371-BB1 Power cord (AC power, 3-pin, black, 1.83 m), for use in Israel

490371-D01 Power cord (AC power, 3-pin, black, 1.83 m), for use in Argentina

490371-D61 Power cord (AC power, 3-pin, black, 1.83 m), for use in India

483377-001 HP Mobile Broadband Module

483377-002 HP Mobile Broadband Module

504593-003 Broadcom 4312G 802.11b/g WiFi Adapter for use in Canada, the Cayman Islands, Guam, Puerto Rico,

the United States, and the U.S. Virgin Islands
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Spare part Description
number

504593-004 Broadcom 4312G 802.11b/g WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Repubilic,
East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

510100-001 High-speed 56K modem for use in all countries and regions except Australia and New Zealand

510100-011 High-speed 56K modem for use in Australia and New Zealand

531993-001 WWAN module, Qualcomm EV-DO HSPA

535593-001 90-W Slimline AC adapter for use in India

537921-001 Bluetooth module (without cable)

572509-001 Intel WiFi Link 6200 802.11 a/g/n for use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia,
Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei,
Bulgaria, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Herzegovina,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the lvory Coast, Jamaica,
Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg,
Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay, the
People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San
Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Venezuela, and
Vietnam

572510-001 Intel Centrino Advanced-N 6200 802.11a/b/g 2x2 for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia,
Brazil, Brunei, Bulgaria, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the lvory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay,
the People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San
Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Venezuela, and
Vietnam
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number

Description

572520-001

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia,
Brazil, Brunei, Bulgaria, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Herzegovina, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Panama, Paraguay,
the People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San
Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, Uruguay, the U.S. Virgin Islands, the United States, Venezuela, and
Vietnam

577170-001

65-W, 3-pin Smart AC adapter for use in India

585984-001

Intel Centrino Wireless-N 1000 802.11b/g 1x2 for use in Russia and Ukraine

587259-001

Processor, Intel Arrandale Core 620M 2.26-GHz

593533-001

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter

593572-001

Battery, 6-cell, 47-Wh (2.2Ah) Li-ion

593573-001

Battery, 9-cell, 93-Wh (2.8Ah) Li-ion

594187-001

Processor, Intel Arrandale 520M 2.4-GHz

594188-001

Processor Intel Arrandale 540M 2.53-GHz

597622-001

Processor, Intel Arrandale i3-330M 2.13-GHz

597623-001

Processor, Intel Arrandale i3-350M 2.26-GHz

597624-001

Processor, Intel Arrandale i5-430M 2.26-GHz

598856-002

Memory module (PC3-10600 shared), 2048-MB

598859-002

Memory module (PC3-10600 shared), 1024-MB

599514-001

Base enclosure, for use with 33.8-cm (13.3-in) models

599515-001

Base enclosure, for use in 35.6-cm (14.0-in) models

599516-001

RTC battery

599517-001

Power connector with cable

599518-001

System board, for use with 33.8-cm (13.3-in) models and discrete graphics subsystem

599520-001

System board, for use with 33.8-cm (13.3-in) models and Unified Memory Architecture (UMA) graphics
subsystem

599521-001

System board, for use with 33.8-cm (13.3-in) models and Unified Memory Architecture (UMA) graphics
subsystem and WWAN module

599522-001

System board, for use with 35.6-cm (14.0-in) models and discrete graphics subsystem

599523-001

System board, for use with 35.6-cm (14.0-in) models and Unified Memory Architecture (UMA) graphics
subsystem

599524-001

USB board and cable

599525-001

Cable kit
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number

599526-001 Display back cover for 33.8-cm (13.3-in) displays without WWAN
599527-001 Display back cover for 35.6-cm (14.0-in) displays without WWAN
599528-001 Display back cover for 33.8-cm (13.3-in) displays with WWAN
599530-001 Display bezel for 33.8-cm (13.3-in) models with webcam

599531-001 Display bezel for 35.6-cm (14.0-in) models with webcam

599532-001 Display bezel for 33.8-cm (13.3-in) models without webcam
599533-001 Display bezel for 35.6-cm (14.0-in) models without webcam
599534-001 Display cable for 33.8-cm (13.3-in) displays with webcam

599535-001 Display cable for 35.6-cm (14.0-in) displays without webcam
599536-001 Display hinge and bracket (left and right) for 33.8-cm (13.3-in) models
599537-001 Display hinge and bracket (left and right) for 35.6-cm (14.0-in) models
599538-001 Blu-ray Disc ROM Drive with SuperMulti DVD +R/RW Double-Layer
599539-001 DVD ROM Drive

599540-001 DVD +RW SuperMulti Double-Layer Drive with LightScribe
599541-001 Hard drive, 250-GB, 7200-rpm

599542-001 Hard drive, 320-GB, 7200-rpm

599543-001 Hard drive, 500-GB, 7200-rpm

599544-001 Fan

599549-001 Palm rest with Touchpad and fingerprint reader for use with 33.8-cm (13.3-in) displays
599550-001 Palm rest with Touchpad and fingerprint reader for use with 35.6-cm (14.0-in) displays
599551-001 Palm rest with Touchpad for use with 33.8-cm (13.3-in) displays, red
599552-001 Palm rest with Touchpad for use with 35.6-cm (14.0-in) displays
599553-001 Display assembly, 33.8-cm (13.3-in) HD (1366x768 resolution)
599554-001 Display assembly, 33.8-cm (13.3-in) HD BrightView

599555-001 Display assembly, 33.8-cm (13.3-in) HD BrightView with webcam
599556-001 Display assembly, 33.8-cm (13.3-in) HD BrightView with webcam and WWAN
599557-001 Display assembly, 33.8-cm (13.3-in) HD with webcam

599558-001 Display assembly, 33.8-cm (13.3-in) HD with webcam and WWAN
599559-001 Display assembly, 35.6-cm (14.0-in) HD (1366x768 resolution)
599560-001 Display assembly, 35.6-cm (14.0-in) HD BrightView

599561-001 Display assembly, 35.6-cm (14.0-in) HD BrightView with webcam
599562-001 Display assembly, 35.6-cm (14.0-in) HD with webcam

599563-001 Plastics kit

599564-001 Rubber kit
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599565-001 Screw kit

599566-001 Speaker assembly, 33.8-cm (13.3-in)

599567-001 Switch cover (includes power button board), 33.8-cm (13.3-in)
599568-001 Switch cover (includes power button board), 35.6-cm (14.0-in)
599569-001 Top cover, for use with 33.8-cm (13.3-in) models
599570-001 Top cover, for use with 35.6-cm (14.0-in) models
599571-001 Webcam module

599572-001 Keyboard, 33.8-cm (13.3-in), for use in the United States
599572-031 Keyboard, 33.8-cm (13.3-in), for use in the United Kingdom
599572-041 Keyboard, 33.8-cm (13.3-in), for use in Germany
599572-051 Keyboard, 33.8-cm (13.3-in), for use in France

599572-061 Keyboard, 33.8-cm (13.3-in), for use in ltaly

599572-071 Keyboard, 33.8-cm (13.3-in), for use in Spain

599572-081 Keyboard, 33.8-cm (13.3-in), for use in Denmark
599572-091 Keyboard, 33.8-cm (13.3-in), for use in Norway

599572-121 Keyboard, 33.8-cm (13.3-in), for use in Canada (French)
599572-131 Keyboard, 33.8-cm (13.3-in), for use in Portugal
599572-141 Keyboard, 33.8-cm (13.3-in), for use in Turkey

599572-161 Keyboard, 33.8-cm (13.3-in), for use in Latin America
599572-171 Keyboard, 33.8-cm (13.3-in), for use in Saudi Arabia
599572-201 Keyboard, 33.8-cm (13.3-in), for use in Brazil

599572-211 Keyboard, 33.8-cm (13.3-in), for use in Hungary
599572-251 Keyboard, 33.8-cm (13.3-in), for use in Russia

599572-261 Keyboard, 33.8-cm (13.3-in), for use in Bulgaria
599572-281 Keyboard, 33.8-cm (13.3-in), for use in Thailand
599572-291 Keyboard, 33.8-cm (13.3-in), for use in Japan

599572-A41 Keyboard, 33.8-cm (13.3-in), for use in Belgium
599572-A81 Keyboard, 33.8-cm (13.3-in), for use in the Czech Republic and Slovakia
599572-AB1 Keyboard, 33.8-cm (13.3-in), for use in Taiwan

599572-AD1 Keyboard, 33.8-cm (13.3-in), for use in South Korea
599572-B31 Keyboard, 33.8-cm (13.3-in), for use in Europe

599572-B71 Keyboard, 33.8-cm (13.3-in), for use in Sweden and Finland
599572-BA1 Keyboard, 33.8-cm (13.3-in), for use in the Adriatic region
599572-BB1 Keyboard, 33.8-cm (13.3-in), for use in Israel
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599572-BG1 Keyboard, 33.8-cm (13.3-in), for use in Switzerland
599572-DD1 Keyboard, 33.8-cm (13.3-in), for use in Iceland
599572-DJ1 Keyboard, 33.8-cm (13.3-in), for use in Greece
599572-DW1 Keyboard, 33.8-cm (13.3-in), for use in French Arabic region
599573-001 Keyboard, 35.6-cm (14.0-in), for use in the United States
599573-031 Keyboard, 35.6-cm (14.0-in), for use in the United Kingdom
599573-041 Keyboard, 35.6-cm (14.0-in), for use in Germany
599573-051 Keyboard, 35.6-cm (14.0-in), for use in France

599573-061 Keyboard, 35.6-cm (14.0-in), for use in Italy

599573-071 Keyboard, 35.6-cm (14.0-in), for use in Spain

599573-081 Keyboard, 35.6-cm (14.0-in), for use in Denmark
599573-091 Keyboard, 35.6-cm (14.0-in), for use in Norway
599573-121 Keyboard, 35.6-cm (14.0-in), for use in Canada (French)
599573-131 Keyboard, 35.6-cm (14.0-in), for use in Portugal
599573-141 Keyboard, 35.6-cm (14.0-in), for use in Turkey

599573-161 Keyboard, 35.6-cm (14.0-in), for use in Latin America
599573-171 Keyboard, 35.6-cm (14.0-in), for use in Saudi Arabia
599573-201 Keyboard, 35.6-cm (14.0-in), for use in Brazil

599573-211 Keyboard, 35.6-cm (14.0-in), for use in Hungary
599573-251 Keyboard, 35.6-cm (14.0-in), for use in Russia

599573-261 Keyboard, 35.6-cm (14.0-in), for use in Bulgaria
599573-281 Keyboard, 35.6-cm (14.0-in), for use in Thailand
599573-291 Keyboard, 35.6-cm (14.0-in), for use in Japan

599573-A41 Keyboard, 35.6-cm (14.0-in), for use in Belgium
599573-A81 Keyboard, 35.6-cm (14.0-in), for use in the Czech Republic and Slovakia
599573-AB1 Keyboard, 35.6-cm (14.0-in), for use in Taiwan
599573-AD1 Keyboard, 35.6-cm (14.0-in), for use in Korea

599573-B31 Keyboard, 35.6-cm (14.0-in), for use in Europe
599573-B71 Keyboard, 35.6-cm (14.0-in), for use in Sweden and Finland
599573-BA1 Keyboard, 35.6-cm (14.0-in), for use in the Adriatic region
599573-BB1 Keyboard, 35.6-cm (14.0-in), for use in Israel

599573-BG1 Keyboard, 35.6-cm (14.0-in), for use in Switzerland
599573-DD1 Keyboard, 35.6-cm (14.0-in), for use in Iceland
599573-DJ1 Keyboard, 35.6-cm (14.0-in), for use in Greece
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599573-DW1

Keyboard, 35.6-cm (14.0-in), for use in French Arabic region

599653-001

Processor heat sink for use with discrete graphics subsystem

599546-001

Processor heat sink for use with Unified Memory Architecture (UMA) graphics subsystem

605556-001

Display back cover for 35.6-cm (14.0-in) displays with webcam and without WWAN

605557-001

Display cable for 33.8-cm (13.3-in) displays without webcam

605558-001

Display cable for 35.6-cm (14.0-in) displays with webcam

605559-001

Speaker assembly, 35.6-cm (14.0-in)

607094-001

Display back cover for 33.8-cm (13.3-in) displays with webcam and without WWAN

607643-001

Display back cover for 33.8-cm (13.3-in) displays without WWAN, red

607644-001

Display back cover for 33.8-cm (13.3-in) displays with webcam and without WWAN, red

607645-001

Display back cover for 35.6-cm (14.0-in) displays without WWAN, red

607646-001

Display back cover for 35.6-cm (14.0-in) displays with webcam and without WWAN, red

607648-001

Palm rest with Touchpad and fingerprint reader for use with 33.8-cm (13.3-in) displays, red

607649-001

Palm rest with Touchpad and fingerprint reader for use with 35.6-cm (14.0-in) displays, red

607650-001

Palm rest with Touchpad for use with 33.8-cm (13.3-in) displays, red

607651-001

Palm rest with Touchpad for use with 35.6-cm (14.0-in) displays, red

607652-001

Switch cover, 33.8-cm (13.3-in), red

607653-001

Switch cover, 35.6-cm (14.0-in), red

608266-001

System board, for use with 35.6-cm (14.0-in) models with discrete graphics subsystem in the People's
Republic of China and Russia

608267-001

System board, for use with 35.6-cm (14.0-in) models with Unified Memory Architecture (UMA) graphics
subsystem in the People's Republic of China and Russia

608736-001

Display assembly, 33.8-cm (13.3-in) HD (1366x768 resolution) , red

608737-001

Display assembly, 33.8-cm (13.3-in) HD BrightView, red

608738-001

Display assembly, 33.8-cm (13.3-in) HD BrightView with webcam, red

608739-001

Display assembly, 33.8-cm (13.3-in) HD with webcam, red

608740-001

Display assembly, 35.6-cm (14.0-in) HD (1366x768 resolution), red

608741-001

Display assembly, 35.6-cm (14.0-in) HD BrightView, red

608742-001

Display assembly, 35.6-cm (14.0-in) HD BrightView with webcam, red

608743-001

Display assembly, 35.6-cm (14.0-in) HD with webcam, red
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e Flat-bladed screwdriver
e  Phillips PO and P1 screwdrivers

° Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

Bf NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Preliminary replacement requirements
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm +£10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

e When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e Conductive bins and other assembly or soldering aids

e Nonconductive foam

e Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This section provides removal and replacement procedures.

There are as many as 83 screws, in 8 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number label

The serial number label, located on the bottom of the computer, provides important information that
you may need when contacting technical support.

Bf NOTE: Serial number label color varies on select models.

) X000 Yo
g——I Serial: X0O0OOCOC | 10100 I 100000 00 W00 KR |

=1 Product: JOOOOOC | 1N I 10 10 000 100 0 A
@ —1— Warranty: 1y1y0y
XOOOXXXX

© | Model:
(1) Product name (4) Warranty period
(2) Serial number (5) Model description (select models)

(3) Product number

Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the rubber kit, spare
part number 535793-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number
Battery

9-cell, 93-Wh (2.8Ah) Li-ion 593573-001

6-cell, 47-Wh (2.2Ah) Li-ion 593572-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside-down on a flat surface with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3.  Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM

B NOTE: This section applies only to select models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).
Remove the SIM:
1. Push on the SIM (1) to release it from the SIM slot.

2. Remove the SIM (2) from the computer.

Install the SIM by inserting it into the SIM slot and pushing until you hear a click.

/A CAUTION: If a SIM is inserted backwards or upside down, the battery may not snap into place
properly and could damage the SIM and the SIM connector.

To prevent damage to the connectors, use minimal force when inserting a SIM.
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Switch cover

Description Spare part number

Switch cover

e  For with 33.8-cm (13.3-in) displays 599567-001
e  For with 33.8-cm (13.3-in) displays, red 607652-001
e  For with 35.6-cm (14.0-in) displays 599568-001
e  For with 35.6-cm (14.0-in) displays, red 607653-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

Remove the switch cover:
1. Position the computer upside down with the rear toward you.

2.  Remove the four PM2.5%3.0 screws in the battery bay.
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3. Open the computer as far as possible.

Component replacement procedures 51



4. Slide the switch cover back (1), and then remove it from the computer (2).

Reverse this procedure to install the switch cover and keyboard.
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Keyboard

Description Spare part number
Keyboard

For computer models with 33.8-cm (13.3-in) displays 599572-xxx

For computer models with 35.6-cm (14.0-in) displays: 599573-xxx

NOTE: For a detailed list of keyboards see the parts list in Computer major components on page 22

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the switch cover (see Switch cover on page 51).

Remove the keyboard:

1. Remove the three Phillips PM2.5x3.0 screws that secure the keyboard to the computer.

Ef NOTE: On computer models with 35.6-cm (14.0-in) displays, remove four screws that secure
the keyboard to the computer.
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2. Slide the keyboard back toward the display (1), and then rotate it right (2) until it rests upside
down on the right side of the computer.

3. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

4. Remove the keyboard (3).
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Memory module

Description Spare part number

Memory module (PC3-10600, 1333-MHz, DDR3, shared)

2048-MB 598856-002

1024-MB 598859-002

Before removing the memory module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the switch cover (see Switch cover on page 51).

Remove the keyboard (see Keyboard on page 53).

NOTE: You can release the keyboard without removing the keyboard cable from the system
board, and then rotate it right until it rests upside down on the right side of the computer to
remove the memory modules.

Remove the memory module:

1.
2.

Position the computer right-side up with the front toward you.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

B NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive

Bf NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
Blu-ray ROM with LightScribe DVD+R/RW SuperMulti DL Drive 599538-001
DVD +RW SuperMulti Double-Layer Drive with LightScribe 599540-001
DVD ROM Drive 599539-001

Before removing the optical drive, follow these steps:

1.

EE)

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the switch cover (see Switch cover on page 51).

Remove the keyboard (see Keyboard on page 53)

NOTE: You can release the keyboard without removing the keyboard cable from the system
board, and then rotate it left until it rests upside down on the left side of the computer to remove
the optical drive .

Remove the optical drive:

1.
2.
3.

Position the computer with the right side toward you.
Remove the Phillips PM2.5x5.0 screw (1) that secures the optical drive to the computer.

Insert a flat-bladed screwdriver or similar tool into the access point on the top cover to the optical
drive bracket (2) and press the to the right to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

5. Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Power button board

Description

Power button board with cable (included with switch cover, see Switch cover on page 51)

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5.  Switch cover (see Switch cover on page 51)

Remove the power button board:

1. Release the ZIF connector that connects the power button board cable to the system board (1),
and then disconnect the power button board cable (2).

2. Gently pull the power button board away from the double-sided tape that secures the board to
the base enclosure.

3. Remove the power button board (3).

Reverse this procedure to install the power button board.
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Speakers

Description Spare part number
Speakers for use in computer models with 33.8-cm (13.3-in) displays 599566-001
Speakers for use in computer models with 35.6-cm (14.0-in) displays 605559-001

Before removing the speakers, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the switch cover and keyboard (see Switch cover on page 51).

Remove the speakers:

1.
2,

Position the computer right-side up with the front toward you.

Disconnect the speaker cable (1) from the system board.

Bf NOTE: The two speakers are connected with a single cable.

3.
4,

Remove the two Phillips PM2.5x3.0 screws (2) that secure the speakers to the base enclosure.

Remove the speaker cable from the clips and routing channel, and then remove the speakers
from the computer (3).
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Reverse this procedure to install the speakers.
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WWAN module

Bf NOTE: Only select models with include a WWAN module (see Product description on page 1).

Description Spare part number

Qualcomm EV-DO HSPA 531993-001

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the switch cover (see Switch cover on page 51)

6. Remove the keyboard (see Keyboard on page 53)
Remove the WWAN module:

1. Position the computer right-side up with the front toward you.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

B¥ NOTE: The red WWAN antenna cable is connected to the WLAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5%x3.0 screws (2) that secure the WWAN module to the computer.
(The module tilts up.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Palm rest

Description Spare part number

Palm rest (includes TouchPad)

e  For use with fingerprint reader and 33.8-cm (13.3-in) displays 599549-001
e  For use with 33.8-cm (13.3-in) displays 599551-001
e  For use with fingerprint reader and 33.8-cm (13.3-in) displays, red 607648-001
e  For use with 33.8-cm (13.3-in) displays, red 607650-001
e  For use with fingerprint reader and 35.6-cm (14.0-in) displays 599550-001
e  For use with 35.6-cm (14.0-in) displays 599552-001
e  For use with fingerprint reader and 35.6-cm (14.0-in) displays, red 607649-001
e  For use with 35.6-cm (14.0-in) displays, red 607651-001

Before removing the palm rest, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the switch cover (see Switch cover on page 51)

6. Remove the keyboard (see Keyboard on page 53)

Remove the palm rest:
1. Position the computer right-side up with the front toward you.

2. Remove the three Phillips PM2.5%3.0 broadhead screws (1) that secure the palm rest to the
computer.
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3. Slide the palm rest to the right (2), and then turn it over from the front edge (3) until it rests
upside down on the top cover.

4. Release the fingerprint reader connector (1), and then remove the fingerprint reader cable (2)
from the system board.

5. Release the TouchPad cable connector (3), and then remove the TouchPad cable (4) from the
system board.

6. Remove the palm rest (5).

Reverse this procedure to install the palm rest.
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Hard drive

B NOTE: The hard drive spare part kit includes a hard drive bracket.

Description Spare part number
500-GB, 7200-rpm hard drive 599543-001
320-GB, 7200-rpm hard drive 599542-001
250-GB, 7200-rpm hard drive 599541-001

Before removing the hard drive, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Palm rest (see Palm rest on page 64)

Remove the hard drive:

1.
2,

Position the computer right-side up with the front toward you.

Remove the two Phillips PM2.0x3.0 screws (1) and loosen the Phillips PM2.5%10.0 captive
screw (2) that secures the hard drive to the computer.

Grasp the Mylar tab on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.
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4. Remove the hard drive (4) from the hard drive bay.

5. Ifitis necessary to replace the hard drive bracket, remove the two Phillips PM3.0x3.0 hard drive
bracket screws (1) from each side of the hard drive.

6. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Component replacement procedures 67



RTC battery

68

Description Spare part number

RTC battery 599516-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a.
b.
c.
d.

Battery (see Battery on page 49)

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Palm rest (see Palm rest on page 64)

Remove the RTC battery:

1. Disconnect the RTC battery connector from the system board (1).

2. Remove the RTC battery from the system board (2).

Reverse this procedure to install the RTC battery.
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WLAN module

Description

Spare part number

Intel® Centrino™ Advanced-N 6200 802.11a/b/g 2x2

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Herzegovina,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman,
Panama, Paraguay, the People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad
and Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin
Islands, the United States, Venezuela, and Vietnam

572510-001

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Herzegovina,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the lvory Coast,
Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman,
Panama, Paraguay, the People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad
and Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin
Islands, the United States, Venezuela, and Vietnam

572520-001

Intel Centrino Wireless-N 1000 802.11b/g 1x2 for use in Russia and Ukraine

585984-001

Intel WiFi Link 6200 802.11a/g/n

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan,
Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia, Brazil, Brunei, Bulgaria,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Herzegovina,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the lvory Coast,
Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman,
Panama, Paraguay, the People’s Republic China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal, Serbia, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad
and Tobago, Turkey, the United Arab Emirates, the United Kingdom, Uruguay, the U.S. Virgin
Islands, the United States, Venezuela, and Vietham

572509-001

Broadcom 4312G 802.11b/g WiFi Adapter

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and the U.S.
Virgin Islands

504593-003
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Description Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 504593-004
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the lvory Coast, Jamaica, Japan, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietham, Yemen, Zaire, Zambia, and
Zimbabwe

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Palm rest (see Palm rest on page 64)
Remove the WLAN module:
1. Position the computer right-side up with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

B NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.
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3.  Remove the two Phillips PM2.5x3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Bluetooth module

Description Spare part number

Bluetooth module (Bluetooth module cable included in the Cable kit, part number 599525-001, 537921-001
see Cable kit on page 32)

Before removing the Bluetooth module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Palm rest (see Palm rest on page 64)

Remove the Bluetooth module:

1.

2
3.
4
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Position the computer right-side up with the front toward you.
Remove the Bluetooth module from the base enclosure (1).
Disconnect the Bluetooth module cable (2), and then remove the Bluetooth module.

Remove the Bluetooth module cable (3) from the system board.
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Reverse this procedure to install the Bluetooth module.
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Heat sink and fan

Bf NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Fan

599544-001

Processor heat sink

For use with discrete graphics subsystems 599653-001

For use with Unified Memory Architecture (UMA) graphics subsystems 599546-001

Before removing the heat sink, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Palm rest (see Palm rest on page 64)

Remove the heat sink:

1.
2.
3.
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Position the computer right-side up with the front toward you.
Remove the six Phillips PM2.5%3.0 screws (1) that secure the heat shield to the top cover.

Remove the Phillips PM2.5%5.0 screw (2) that secures the heat shield to the top cover.
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4. Lift the right edge of the heat shield to disengage the tabs on the left side of the heat shield from
the top cover, and then remove the heat shield (3).

u
u
u
u
u
u
!

5. Disconnect the fan cable from the system board (1).

6. Loosen the 2.0x5.0 captive screw from the system board, and then remove the fan (3).

7. Following the sequence stamped into the heat sink, loosen the four PM2.5x10.0 captive screws
(1) that secure the heat sink to the processor.
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Bf NOTE: Loosen the two additional screws that secure the heat sink to the graphics devices on
models with discrete graphics subsystem memory.

8. Lift the heat sink off the processor (2), and then lift the heat sink up and to the right to remove
the heat sink from the base enclosure (3).

B NOTE: The thermal material must be thoroughly cleaned from the surfaces heat sink for the
discrete system board (1), (2), and (3), and the system board (4), (5), and (6) each time the heat sink
is removed. Replacement thermal material is included with all heat sink, system board, and processor

spare part kits.

B NOTE: The thermal material must be thoroughly cleaned from the surfaces of heat sink for the UMA
system board (1), (2), and (3) and the system board components (3), (4) and (5) each time the heat
sink is removed. Replacement thermal material is included with all heat sink, system board, and
processor spare part kits.

Chapter 4 Removal and replacement procedures



Reverse this procedure to install the heat sink and fan.
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Processor

Bf NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Processor (includes replacement thermal material) (not illustrated)

e Intel Arrandale 520M 2.4-GHz 594187-001
e Intel Arrandale 540M 2.53-GHz 594188-001
e Intel Arrandale Core 620M 2.26-GHz 587259-001
e Intel Arrandale i3-330M 2.13-GHz 597622-001
e Intel Arrandale i3-350M 2.26-GHz 597623-001
e Intel Arrandale i5-430M 2.26-GHz 597624-001

Before removing the processor, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

a. Switch cover (see Switch cover on page 51)
b. Keyboard (see Keyboard on page 53)
c. Optical drive (see Optical drive on page 57)
d. Speakers (see Speakers on page 60)
e. Palm rest (see Palm rest on page 64)

f. Top cover (see Top cover on page 89)

Remove the processor:

1.
2,

Position the computer right-side up with the front toward you.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.
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3. Lift the processor (2) straight up and remove it.

Ef NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Power connector cable

B NOTE: The power connector cable is included in the Cable kit on page 32, part number
599525-001.

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5.  Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Fan and heat sink (see Heat sink and fan on page 74)

d. Speakers (see Speakers on page 60)

Remove the power connector cable.
1. Position the computer right-side up with the front toward you.
2. Release the power connector cable from the system board (1).

3.  Remove the modem cable (2) from the routing in the base enclosure.

4. Remove the power connector cable

Reverse this procedure to install the power connector cable.
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Display assembly

Bf NOTE: The display assembly spare part kit includes 2 WLAN antennas and cables.

Description Spare part number

Display assembly (includes 2 WLAN antennas and cables and, on select computer models, 2 WWAN antennas and cables)

NOTE: WWAN is available only on select models with 33.8-cm 13.3-in displays.

e 33.8-cm (13.3-in) HD (1366x768 resolution) 599553-001
e  33.8-cm (13.3-in) HD BrightView 599554-001
e  33.8-cm (13.3-in) HD BrightView with webcam 599555-001
e  33.8-cm (13.3-in) HD BrightView with webcam and WWAN 599556-001
e  33.8-cm (13.3-in) HD with webcam 599557-001
e  33.8-cm (13.3-in) HD with webcam and WWAN 599558-001
e  33.8-cm (13.3-in) HD (1366x768 resolution) , red 608736-001
e  33.8-cm (13.3-in) HD BrightView, red 608737-001
e  33.8-cm (13.3-in) HD BrightView with webcam, red 608738-001
e  33.8-cm (13.3-in) HD with webcam, red 608739-001
e  35.6-cm (14.0-in) HD (1366x768 resolution) 599559-001
e  35.6-cm (14.0-in) HD BrightView 599560-001
e  35.6-cm (14.0-in) HD BrightView with webcam 599561-001
e 35.6-cm (14.0-in) HD with webcam 599562-001
e 35.6-cm (14.0-in) HD (1366x768 resolution), red 608740-001
e  35.6-cm (14.0-in) HD BrightView, red 608741-001
e  35.6-cm (14.0-in) HD BrightView with webcam, red 608742-001
e  35.6-cm (14.0-in) HD with webcam, red 608743-001
Display bezel

e  For use with 33.8-cm (13.3-in) displays with webcam 536421-001
e  For use with 35.6-cm (14.0-in) displays with webcam 536424-001
e  For use with 33.8-cm (13.3-in) displays without webcam 536423-001
e  For use with 35.6-cm (14.0-in) displays without webcam 536422-001
Webcam module 599571-001

Display panel (included with display assembly)

Display hinge kit

e Display hinge and panel bracket (left and right) for 33.8-cm (13.3-in) displays 599536-001

o Display hinge and panel bracket (left and right) for 35.6-cm (14.0-in) displays 599537-001

Display cable (includes microphone and, on select models, webcam connector)

e Display cable for use with 33.8-cm (13.3-in) displays with webcam 599534-001
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Description Spare part number

e Display cable for use with 35.6-cm (14.0-in) displays with webcam 605558-001
o Display cable for use with 33.8-cm (13.3-in) displays without webcam 605557-001
e Display cable for use with 35.6-cm (14.0-in) displays without webcam 599535-001

WLAN antennas and cables

WWAN antennas and cables

Display back cover

e  For use with 33.8-cm (13.3-in) displays without WWAN 599526-001
e  For use with 35.6-cm (14.0-in) displays without WWAN 599527-001
e  For use with 33.8-cm (13.3-in) displays with WWAN 599528-001
e  For use with 35.6-cm (14.0-in) displays with webcam and without WWAN 605556-001
e  For use with 33.8-cm (13.3-in) displays with webcam and without WWAN 607094-001
e  For use with 33.8-cm (13.3-in) displays without WWAN, red 607643-001
e  For use with 33.8-cm (13.3-in) displays with webcam and without WWAN, red 607644-001
e  For use with 33.8-cm (14.0-in) displays without WWAN, red 607645-001
e  For use with 35.6-cm (14.0-in) displays with webcam and without WWAN, red 607646-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Speakers (see Speakers on page 60)

d. Palm rest (see Palm rest on page 64)

e. WWAN cables (see WWAN module on page 62)
f.  WLAN cables (see WLAN module on page 69)

Remove the display assembily:
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/A CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other computer components.

1. Remove the five T8 slotted-Torx M2.5x6.0 screws (1) that secure the display assembly to the
base enclosure.

B NOTE: Your model of the computer have four screws.

2. Disconnect the display cable from the system board (2), and remove all cables from the routing
channels along the top cover (3).

3. Lift the display assembly (4) straight up and remove it from the base enclosure.
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4. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the
four Mylar screw covers (1) and the four T8 slotted-Torx M2.5%6.0 screws (2) that secure the
display bezel to the display assembly. The screw covers are available in the rubber kit, spare
part number 599564-001.
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5. Remove the bezel:

a. Flex the top of the bezel from the inside edge until it disengages from the display back
cover (1).

b. Flex the bottom of the bezel from the inside edge until it disengages from the display back
cover (2).

c. Flex the inside edge of the left side and the right side of the bezel until it disengages from
the display back cover (3).

d. Remove the display bezel from the display back cover (4).

N __ Lo
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6. Ifitis necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display back cover (1), disconnect the webcam cable from the module
(2), and then remove the webcam.

Bf NOTE: To replace the webcam module in the display enclosure, align the holes on the
webcam module with the pins on the display enclosure and press onto the double-sided tape.

7. Ifitis necessary to replace the display hinges, remove the display panel by removing the four T8
slotted-Torx 2.5%5.0 screws (1) that secure the panel to the bottom of the display back cover
and the two T8 slotted-Torx 2.5%3.0 screws (2) that secure the display panel to the top of the
display back cover.
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8. Lift the top of the display panel away from the back cover (3), and then remove the display panel

(4).

9. Remove the four Phillips PM2.0%3.0 screws (1) that secure the display hinges to the display
panel, and then remove the display hinges (2). The left and right display hinges are available in

the display hinge kit.

Y

10. If it is necessary to replace the display/webcam cable, turn the display panel upside-down and
peel back the tape that secures the display cable to the display panel (1), and then release the

connector locking bar (2).
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11. Release the cable from the display panel connector (3).

Ef NOTE: The display cable includes the microphone and webcam connector.

12. Gently pull the integrated microphone (1) from the clips at the top of the display back cover,
remove the display cable from the clips and routing channels (2) along the bottom of the display

back cover, and then remove the display cable (3). The display/mic/webcam cable is included in
the display cable kit.
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13. Ifitis necessary to remove the wireless antennas and cables:

a. Detach the WLAN antennas (1) and the WWAN antennas (2) from the adhesive on the
back cover, and then route the cables through the clips (3) that secure the antenna cables
to the display back cover.

b. Remove the wireless antennas and cables.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number
Top cover

For use with 33.8-cm (13.3-in) displays 599569-001

For use with 35.6-cm (14.0-in) displays 599570-001

Before removing the top cover, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

a
b.
c.
d.

e.

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Speakers (see Speakers on page 60)

Optical drive (see Optical drive on page 57)

Palm rest (see Palm rest on page 64)

Remove the top cover:

1.
2,

Position the computer right-side up with the front toward you.

Remove the 14 T8 slotted-Torx 2.5%5.0 screws (1) and the 3 PM2.0x3.0 screws (2) that secure

the top cover to the base enclosure.
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3. [Ifinstalled, remove the ExpressCard slot bezel (1), release the top cover from the sides of the
base enclosure (2), and then remove the top cover (3).

Reverse this procedure to install the top cover.
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Modem module

Description Spare part number

Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the cable kit. See Cable kit on page 32 for more cable kit spare part

information.
High-speed 56K modem for use in all countries and regions except Australia and New Zealand 510100-001
High-speed 56K modem for use in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).
Remove the following components:

Switch cover (see Switch cover on page 51)

a.
b. Keyboard (see Keyboard on page 53)

Optical drive (see Optical drive on page 57)

a o

Speakers (see Speakers on page 60)

e. Palm rest (see Palm rest on page 64)

f. Top cover (see Top cover on page 89)

Remove the modem module:

Position the computer right-side up with the front toward you.

Remove the two Phillips PM2.5x3.0 screws (1) that secure the modem module to the system
board.

Lift the modem module (2) straight up to disconnect it from the system board.
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4. Disconnect the modem module cable (3).

5. Remove the modem module.

Reverse this procedure to install the modem module.
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System board

Bf NOTE: The system board spare part kit includes replacement thermal material.

Description

Spare part number

System board (includes replacement thermal material)

e  For use with UMA graphics subsystem, WWAN module, and 33.8-cm (13.3-in) displays 599521-001
e  For use with UMA graphics subsystem and 33.8-cm (13.3-in) displays 599520-001
e  For use with discrete graphics subsystem and 33.8-cm (13.3-in) displays 599518-001
e  For use with UMA graphics subsystem and 35.6-cm (14.0-in) displays 599523-001
e  For use with discrete graphics subsystem and 35.6-cm (14.0-in) displays 599522-001
e  For use with UMA graphics subsystem and 35.6-cm (14.0-in) displays in the People's 608267-001
Republic of China and Russia
e  For use with discrete graphics subsystem and 35.6-cm (14.0-in) displays in the People's 608266-001

Republic of China and Russia

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 49).

5. Remove the following components:

SIM (see SIM on page 50)

a
b. Switch cover (see Switch cover on page 51)

c. Keyboard (see Keyboard on page 53)

d. Speakers (see Speakers on page 60)

e.  WWAN module (see WWAN module on page 62)

f. Palm rest (see Palm rest on page 64)

g. Bluetooth module and cable (see Bluetooth module on page 72)
h. WLAN module (see WLAN module on page 69)

i. Hard drive (see Hard drive on page 66)

j. Optical drive (see Optical drive on page 57)

k. Display assembly (see Display assembly on page 81)

I.  Top cover (see Top cover on page 89)

m. Power connector and cable
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When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e Memory module (see Memory module on page 55)
e  WLAN module (see WLAN module on page 69)
e  WWAN module (see WWAN module on page 62)

e Modem module (see Modem module on page 91)

e  Processor (see Processor on page 78)

Remove the system board:
1. Position the computer right-side up with the front toward you.

2. Remove the T8 slotted-Torx 2.5%5.0 screw (1) that secures the system board to the base
enclosure.

3. Disconnect the USB board cable from the system board (2).
4. Use the ODD connector (3) to lift the right side of the system board from the base enclosure (4).

5. Lift the system board up and to the right to remove the system board (5).

?

Reverse this procedure to install the system board.

USB connector board

Description Spare part number

USB board with cable 599524-001
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Before removing the USB connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the following components:

a
b.

® o o

=h

g.
h

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Optical drive (see Optical drive on page 57)

Speakers (see Speakers on page 60)

Palm rest (see Palm rest on page 64)

Hard drive (see Hard drive on page 66)

Display assembly (see Display assembly on page 81)

Top cover (see Top cover on page 89)

System board (see System board on page 93)

Remove the USB connector assembly:

1. Position the computer right-side up with the right side toward you.

2. Release the USB connector board cable from the base enclosure clips and routing channel (1).

3.  Remove the USB connector assembly (2) from the base enclosure.

Reverse this procedure to install the USB connector assembly.
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Modem module cable

Bf NOTE: The modem module cable with RJ11 connector is included in the Cable kit on page 32, part
number 599525-001.

Before removing the modem module cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5.  Remove the following components:

a. Switch cover (see Switch cover on page 51)
b. Keyboard (see Keyboard on page 53)

c. Optical drive (see Optical drive on page 57)
d. Speakers (see Speakers on page 60)

e. Palm rest (see Palm rest on page 64)

f.  Hard drive (see Hard drive on page 66)

g. Display assembly (see Display assembly on page 81)
h

Top cover (see Top cover on page 89)

i. System board (see System board on page 93)

j- USB connector board and cable (see USB connector board on page 94)

Remove the modem cable.
1. Position the computer right-side up with the front toward you.

2. Release the modem RJ11 connector from the base enclosure clips (1).
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3.  Remove the modem cable (2) from the routing in the base enclosure.

4. Remove the modem cable.

Reverse this procedure to install the modem cable.
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5 Computer Setup

Computer Setup in Windows 7

To view the drives installed on the computer, select Start>Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, will be assigned the next available drive letter.

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer.

2. Before your operating system opens and while the “Press the ESC key for Startup Menu”
message is displayed in the lower-left corner of the screen, press esc.

3. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

B NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
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3. Select the File, Security, Diagnostics, or System Configuration menu.

4. To exit Computer Setup, choose one of the following methods:

To exit Computer Setup without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

use the tab key and the arrow keys to select File>lgnore changes and exit, and then
press enter.

To save your preferences and exit Computer Setup menus, click the Save icon in the
lower-left corner of the screen, and then follow the instructions on the screen.

Use the tab key and the arrow keys to select File>Save changes and exit and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing esc while the
"Press the ESC key for Startup Menu" message is displayed in the lower-left corner of the
screen.

o &~ @ N

Press 10 to enter BIOS Setup.
Use the arrow keys to select File>Restore defaults, and then press enter.
When the confirmation dialog box opens, press f10.

To save your preferences and exit Computer Setup, use the arrow keys to select File>Save

changes and exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory

settings.

Computer Setup menus

The menu tables in this section provide an overview of the Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu
Select To do this
System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.
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Select

To do this

Set system date and time

Change date and time
e  Setdate: MM:DD:YYYY
e  Settime: HH:MM

System Diagnostics

e F1: System information
e F2: Start-up test
e F3:Run-in test

e F4:Hard disk test

Restore defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Reset BIOS security to factory default

Restore the BIOS security settings to the factory default.

Ignore changes and exit

Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Administrator Tools

BIOS administrator password

Enter, change, or delete a BIOS administrator password.

User Management (requires a BIOS administrator password)

Create New BIOS User Account password

e  Select from a list of BIOS users.

e  Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enroliment

Enable/disable HP SpareKey enroliment (enabled by
default).

User Tools

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

e Last Pass: Displays Disk Sanitizer Completion Report

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Set a Startup Menu delay in seconds.

e Set the MultiBoot Express Boot Popup delay in
seconds.

e Enable/disable Custom Logo (disabled by default).
e Enable/display Display Diagnostic URL.
e Enable/disable SD card boot.
e Enable/disable floppy boot.
e Enable/disable PXE Internal NIC boot.
e  Set the UEFI boot order: Windows Boot Manager.
e Set the legacy boot order:
° 1st boot device: Notebook hard drive
° 2nd boot device: USB floppy
° 3rd boot device: USB CD-ROM
° 4th boot device: USB hard drive
° 5th boot device: Notebook Ethernet

° 6th boot device: SD card
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Select To do this

Device configurations e  Enable Fn Key Switch

e Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when your operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

e  Enable/disable fan always on while connected to an AC
outlet.

e Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security.

e Enable/disable LAN power saving mode.

e  Setthe SATA (Serial Advanced Technology
Attachment) device mode. The following options are
available:

o AHCI (Advanced Host Controller Interface)
o IDE (Integrated Drive Electronics)
e Enable/disable HP QuickLook.

e Enable/disable HP QuickLook preboot authentication on
HP QuickLook boot.

° Enable/disable HP QuickWeb.

e Enable/disable HP QuickWeb: Write Protect (disabled
by default).

e Enable/disable Intel® HT Technology.
e Enable/disable Wake on USB (disabled by default).

e  Enable/disable Numlock state at boot: Off /On (disabled
by default).
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Select To do this

Built-in device options e Enable/disable the wireless switch state.
e Enable/disable embedded WLAN device radio.
e Enable/disable Network Interface Controller (NIC).

e Enable/disable LAN/WLAN Switching (disabled by
default).

e  Set the wake on LAN state.

° Disabled

° Boot to Network

Follow Boot Order

e Enable/disable the integrated camera (webcam).
e Enable/disable Power Monitor Circuit.
e Enable/disable the audio device.
e Enable/disable the microphone.

e Enable/disable the internal speakers.

Port options Enable/disable USB port.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.

Computer Setup in Windows Vista and Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.
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To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

Bf NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press 10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

Bf NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore defaults.

Follow the on-screen instructions.

o &~ @ N

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.
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Your changes go into effect when the computer restarts.

EBf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.

e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) e  Create a new BIOS user account.

e View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enroliment Enable/disable HP SpareKey enroliment (disabled by
default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security

questions and answers used if you forget your password.

DriveLock Passwords e  Enable/disable DriveLock on any computer hard drive
(enabled by default).

e Change a DriveLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the

computer.
Automatic DriveLock Enable/disable Automatic DriveLock support.
Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary

hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics Menu e  System Information—Displays the following information:

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

e  Start-up Test—Verifies the system components needed
for starting the computer.

e  Run-In Test—Runs a comprehensive check on system
memory.

e Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

e  Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta Startup Menu delay (in seconds).

Enable/disable Custom Logo (disabled by default).

Enable/disable Display Diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (enabled by default).
Enable/disable SD Card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE Internal NIC boot (disabled by
default).

Set the Express Boot Popup delay in seconds.

Set the boot order.

Device Configurations °

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable fan always on while connected to an AC
outlet (disabled by default).

Enable/disable Data Execution Prevention (select
models only; disabled by default). When enabled, the
processor can disable some virus code execution,
which helps to improve computer security.

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)
0 IDE (Integrated Drive Electronics)

NOTE: Auvailability of the options above varies by
computer model.

Enable/disable HP QuickLook 2 (enabled by default).

Enable/disable Virtualization Technology (select models
only; disabled by default).

Enable/disable Dual Core CPU (enabled by default).

Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).
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Select To do this

Built-In Device Options e Enable/disable the wireless button state (enabled by
default).

° Enable/disable embedded WWAN device radio
(enabled by default).

° Enable/disable embedded Bluetooth® device radio
(enabled by default).

e Enable/disable the Network Interface Controller (LAN)
(enabled by default).

e  Setthe wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

e Enable/disable the optical disc drive (enabled by
default).

° Enable/disable the microphone.
e Enable/disable a modem device (enabled by default).

e Enable/disable the embedded WLAN device (enabled
by default).

e Enable/disable LAN/WLAN switching (disabled by
default).

e Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default) NOTE: All port options are enabled by default.
e Enable/disable the ExpressCard slot.
e Enable/disable the flash media reader.
e  Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.
Restore Security Defaults Restore the default security settings.

Computer Setup in Linux
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
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NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to
navigate and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is
displayed in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.
e To close open dialog boxes and return to the main Computer Setup screen, press esc.
e To view navigation information, press 1.
e To change the language, press f2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing 10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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B NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup Password

Enter, change, or delete a setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options

e Enable/disable stringent security.

e Enable/disable the password requirement on computer
restart.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive.

e Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.
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Diagnostics menu

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the
system or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, 10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

o 1st boot device: USB CD-ROM

° 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

° 4th boot device: Notebook hard drive

° 5th boot device: USB hard disk

° 6th boot device: Network controller

Device Configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

33.8-cm (13.3-in) models 35.6-cm (14.0-in) models

Dimensions

Depth

22.81 cm (8.98 in) 23.24 cm (9.15 in)

Width

32.2 cm (12.68 in) 33.6 cm (13.23 in)

Height (front to rear)

27.0to 35.3 cm (1.07 to 1.39 in) 27.0 to 35.0 cm (1.07 to 1.38 in)

Weight

e  With 6-cell battery, no WWAN, no Bluetooth, no
modem, one memory module, and optical disk
drive

<2.15 kg (4.74 Ibs) <2.27 kg (5.0 Ibs)

e  With 6-cell battery, no WWAN, no Bluetooth, no

modem, one memory module; without optical disk

drive

<2.02 kg (4.45 Ibs ) <4.71kg (2.14 Ibs )

Input power

Operating voltage

18.5Vdc@4.74 A-90 W

Operating current

474 A

Temperature

Operating (not writing to optical disc)

0°C to 35°C (32°F to 95°F)

Operating (writing to optical disc)

5°C to 35°C (41°F to 95°F)

Nonoperating

-20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating

-15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating

-15 m to 12,192 m (-50 ft to 40,000 ft)

Shock

Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
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33.8-cm (13.3-in) models 35.6-cm (14.0-in) models

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

33.8-cm (13.3-in) display specifications

Dimensions

Height 20.83 cm (8.2 in)
Width 27.94cm (11.0in)
Diagonal 33.6 cm (13.3in)

Number of colors

Up to 16.8 million

Contrast ratio

250:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.279 x 0.279 mm

Format SD: 1280 x 800; HD: 1366 x 768
Configuration RGB vertical stripe

Backlight LED

Character display 80 x 25

Total power consumption 4.0W

Viewing angle +40° horizontal, +120/-40° vertical (typical)
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35.6-cm (14.0-in) display specifications

Dimensions

Height 17.6 cm (17.6 cm)
Width 31.1 cm (12.24 in)
Diagonal 35.7 cm (14.06 in)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.259 x 0.259 mm

Format 1280 x 800; HD: 1366 x 768
Configuration RGB vertical stripe

Backlight LED

Character display 80 x 25

Total power consumption 4.0W

Viewing angle +40° horizontal, +120/-40° vertical (typical)

Hard drive specifications

500-GB* 320-GB* 250-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm
Weight 101g 1019 101g
Interface type SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 1.0 ms 1.5ms 2.0ms
Average 14.0 ms 12.0 ms 12.0 ms
Maximum 22.0ms 22.0ms 22.0ms
Logical blocks 976,773,168 625,142,448 488,397,168
Disc rotational speed 7200 rpm 7200 rpm 7200 rpm

5°C to 55°C (41°F  5°C to 55°C (41°F  5°C to 55°C (41°F
to 131°F) to 131°F) to 131°F)

Operating temperature
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500-GB* 320-GB* 250-GB*

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

DVD ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2),
CD Digital Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode
2, Form 1 and Form 2), CD-R, CD-RW, Photo CD (single and multisession),

CD-Bridge
Random access time
DVD <125 ms
CD <100 ms
Cache buffer 512 KB
Data transfer rate
CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)
DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
Multiword DMA mode 2 16.6 MB/s

DVD*RW SuperMulti Double-Layer Drive with LightScribe
specifications

Applicable disc

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time

DVD <230 ms
CD <175 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec
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24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode

Blu-ray ROM with LightScribe DVDR/RW SuperMulti DL
Drive specifications

Applicable disc

Read

BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write

DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time

BD <230 ms
DVD <180 ms
CD <180 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
4X BD 18,000 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
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Applicable disc

1X BD-ROM

4,500 KB/sec

1X BD-R read

4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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System resource specifications

You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources you can access from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

/A CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:
1. Select Start > Computer.
2. Click System properties near the top of the Computer folder.
3.  Onthe left, click Device Manager.
4. On the View menu, click one of the following:
e Resources by type
e Resources by connection
To view resource settings in Windows XP:
1. Select Start > My Computer, or double-click My Computer on the desktop.
2. Under System Tasks, click View system information.
3. In the System Properties window, select the Hardware tab.
4. Click Device Manager.
5. On the View menu, click one of the following:
e Resources by type

e Resources by connection
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7 Backup and recovery

Windows 7 backup and recovery

To protect your information, use Windows® Backup and Restore to back up individual files and
folders, back up your entire hard drive (select models only), create system repair discs (select models
only), or create system restore points. In case of system failure, you can use the backup files to
restore the contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

Bf NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit>Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

Bf NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start>All Programs>Maintenance>Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Bf NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Recovering

In case of system failure or instability, the computer provides the following tools to recover your files.

e Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use f11 recovery tools to recover your original hard drive image. The
image includes the Windows operating system and software programs installed at the factory.

Bf NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system.
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/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. select Start, right-click
Computer, click Manage, and then click Disk Management.

B NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 Operating System Operating System DVD and the Driver
Recovery disc (both purchased separately). For additional information, contact technical support
by selecting Start>Help and Support>Contact support.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press 11 for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Bf NOTE: Windows 7 provides additional recovery tools through the operating system. For additional
information, go to Help and Support.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows 7
Operating System DVD to reboot the computer and repair the operating system. For additional
information, contact technical support by selecting Start>Help and Support>Contact support.

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e Backing up individual files and folders

e  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

Bf NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

B NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

Bf NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

Bf NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

=’ NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)”’ section in this guide.

3. Restart the computer, and then press 8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

B NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

Bf NOTE: |If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

/A CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

N o g o

Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files
and folders or create recovery points. In case of system failure, you can use the backup files to
restore your computer.

Windows provides the following options:

e Backing up individual files and folders
e Backing up all files and folders

e  Scheduling automatic backups

e  Creating recovery points

e Recovering information

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

e  Store personal files in the My Documents folder, and back it up periodically.

e Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.
c. Open a word-processing document, click Edit > Paste.
The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

e Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1. If possible, back up all personal files.
2. Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.
3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs

/\ CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:
1. If possible, back up all personal files.

Insert the Operating System disc into the optical drive.

Shut down the computer.

Turn on the computer.

Follow the on-screen instructions to install the operating system.

o o ~ 0N

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.

Linux backup and recovery

Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.
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To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. Restart the computer, and then press 11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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8 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground
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Audio-out (headphone)

i

Signal

Audio out, left channel

Audio out, right channel

Ground
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External monitor

@O 006

®000

®00006

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

1917151311 9 7 5 3 1

NrATATAvATATATATATASS

1816 1412108 6 4 2

Pin Signal

1 Transition minimized differential signal (TMDS) data 2+
2 TMDS data 2 shield

3 TMDS data 2—

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0—

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 Consumer electronic control (CEC)
14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

HDMI
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RJ-11 (modem)

1234|Il5

Pin Signal
1 Unused
2 Tip

3 Ring

4 Unused
5 Unused
6 Unused
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RJ-45 (network)

LTEETT
12345678
[ —

Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused
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Universal Serial Bus

1 2 3 4
I-_-_--.I

Pin Signal

1 +5 VDC (4.75 V minimum under a continuous 0.5-A load)
2 Data -

3 Data +

4 Ground
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eSATA/USB

r

=1 57

GEERR

— L

=B =] =]
|1 1 23 4 |J
- ' —

Pin Signal

1 USB +5 VDC

2 USB Data -

3 USB Data +

4 USB Ground

S1 eSATA Ground

S2 eSATA Transmit Data A+
S3 eSATA Transmit Data A-
S4 eSATA Ground

S5 eSATA Receive Data B-
S6 eSATA Transmit Data B+
S7 eSATA Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
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Country/region Accredited agency Applicable note number

Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.  The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.  The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

Ef NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

Q9 —-

Bf NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

o

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

¢
i-

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

/ E
L H

o

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.
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16. Turn the display panel upside-down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

— ¢
I

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.

Display 149



Index

A
AC adapter
identifying 20
AC adapter light, identifying 16
AC adapter, spare part
numbers 34
antenna, disconnecting 62, 70
antennas
WLAN 19
WWAN 19
applications key, Windows 13
audio, product description 3
audio-in (microphone) jack
pin assignments 134
audio-in (microphone) jack,
identifying 14
audio-out (headphone) jack
pin assignments 135
audio-out (headphone) jack,
identifying 14

B
backing up
Windows Vista 128
Windows XP 131
Backup and Restore
Backup and Restore
Center 127,128
base enclosure, spare part
number 28
battery
removal 49
spare part number 28, 49
battery bay 17
battery release latches,
identifying 17
battery, identifying 20
bays
battery 17
BIOS administrator
password 108
Blu-ray Disc ROM Combo Drive
spare part number 29, 33

125, 126
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Blu-ray ROM with LightScribe DVD
*R/RW SuperMulti DL Drive
removal 57
spare part number 57
specifications 122
Bluetooth module
cable 26
removal 72
spare part number 26, 72
Bluetooth module cable,
illustrated 32
boot options 102, 110, 116
boot order 102, 110, 116
built-in device
Bluetooth device radio 111
embedded WLAN 111
integrated camera 111
LAN/WLAN switching 111
microphone 111
modem 111
Network Interface Controller
(LAN) 111
optical disc drive 111
options 111
Wake on LAN 111
wireless button 111
WWAN device radio 111
buttons
power 12

C
cable kit
contents 32
spare part number 32
cables, service considerations 44
caps lock light, identifying 11
chipset, product description 1
components
additional hardware 20
bottom 17

display 18
front 14
left-side 16

right-side 15
top 10
computer feet
locations 48
spare part number 48
Computer Setup
accessing 104, 111
Diagnostics menu 109, 115
File menu 99, 107, 113
navigating and
selecting 98, 104, 112
restoring factory
settings 99, 105, 112
Security menu 101, 108, 114
System Configuration
menu 102, 110, 116
using 104, 112
computer specifications 118
connector, power 16
connectors, service
considerations 44
cord, power 20

D
device configurations 110
Diagnostics menu 109, 115
discs

Driver Recovery 132

Operating System 132
Disk Sanitizer 108
diskette drive

precautions 44

product description 3
display assembly

removal 81

spare part numbers 23, 81
display bezel

removal 84

spare part number 84
display component recycling 144
display hinge, removal 86
display panel

removal 86

display specifications 119, 120



drive light, identifying 14
DriveLock
automatic 108
password 108
Driver Recovery disc 132
drives
boot order
optical 15
preventing damage 44
Dual Core CPU 110
DVD-ROM Drive
removal 57
spare part number
specifications 121
DVDxRW Double-Layer Drive with
LightScribe
precautions 44
DVD+RW SuperMulti Double-
Layer Drive with LightScribe
spare part number 29, 33, 57
specifications 121

102, 110, 116

29, 33, 57

E
electrostatic discharge 45
embedded keypad keys,
identifying 13
error log 109
eSATA port
pin assignments 141
eSATA port, identifying 16
esc key, identifying 13
Ethernet, product description 4
Execution Disable 110
ExpressCard slot bezel,
illustrated 31
ExpressCard slot, identifying 16
external media cards, product
description 4
external monitor port
pin assignments 136
external monitor port,
identifying 16

F
f11 recovery 130
fan

removal 74

spare part number 25, 74

feet

locations 48

spare part number 48
File menu 99, 107, 113
fingerprint reader, identifying 12
fn key, identifying 13
function keys, identifying 13

G

graphics, product description 1

grounding equipment and
methods 47

H
hard disk test 109
hard drive
precautions 44
product description 3
removal 66
spare part numbers 28, 33, 66
specifications 120
hard drive bracket, removal 67
hard drive recovery 130
HDMI port, pin assignments 137
headphone (audio-out) jack
pin assignments 135
heat sink
removal 74
spare part number 26, 74
HP Mobile Broadband Module
spare part number 36
HP QuickLook 2 110
HP SpareKey enroliment 108

I
internal display switch,

identifying 12, 18
internal microphone,
identifying 18

J

jacks

audio-in (microphone) 14
audio-out (headphone) 14
RJ-11 (modem) 15
RJ-45 (network) 16

K
keyboard
product description 5

removal 53
spare part number 23, 53
keys

embedded keypad 13
esc 13

fn 13

function 13

Windows applications 13
Windows logo 13

L
language, changing in Computer
Setup 110
latches, battery release 17
legacy support,
USB 98, 103, 104, 110, 112
, 116
lights
AC adapter 16
caps lock 11

drive 14

optical drive 15
power 11
QuickLook 11
QuickWeb 11
TouchPad 10, 11

webcam 18

M
mass storage devices, spare part
numbers 33
Media Card Reader,
identifying 14
memory module
product description 2
removal 55
spare part numbers 55
spare pat number 26, 55
microphone (audio-in) jack
pin assignments 134
model name 1
modem jack, pin
assignments 138
modem module
product description 3
removal 91
spare part numbers 26, 91
monitor port
pin assignments 136
monitor port, external 16
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N

network jack, pin
assignments 139
numeric keypad 13

o

Operating System disc 132

operating system, product

description 5

optical drive
precautions 44
product description 3
removal 57

spare part number 29, 33, 57

specifications 121, 122
optical drive blank, illustrated 31
optical drive light, identifying 15
optical drive, identifying 15

P
packing guidelines 46
palm rest
removal 64
spare part number 25, 64
spare part numbers 64
panels, product description 1
passwords 101, 108, 114
pin assignments
audio-in jack 134
audio-out (headphone)
jack 135
eSATA port 141
external monitor port 136
HDMI 137
headphone (audio-out)
jack 135
microphone (audio-in)
jack 134
modem jack 138
monitor port 136
network jack 139
RJ-11 138
RJ-45 (network) jack 139
Universal Serial Bus (USB)
port 140
plastic parts 43
Plastics Kit
contents 31
spare part number 31
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pointing devices, product
description 5
port options
ExpressCard slot 111
flash media reader 111
USB port 111
ports
eSATA 16
external monitor 16
HDMI 16
product description 4
USB 15, 16
power button board
removal 59
spare part number 59
power button, identifying 12
power cable, illustrated 32
power connector
spare part number 28
power connector, identifying 16
power cord
set requirements 142
spare part numbers 34
power cord, identifying 20
power light, identifying 11
power requirements, product
description 5
processor
product description 1
removal 78
spare part numbers 27,78
product description
audio 3
chipset 1
diskette drive 3
Ethernet 4
external media cards 4
graphics 1
hard drives 3
keyboard 5
memory module 2
modem module 3
operating system 5
optical drives 3
panels 1
pointing devices 5
ports 4
power requirements 5
processors 1
product name 1

security 5
serviceability 8
visual 3
wireless 4
product name 1

Q
QuickLook light, identifying 11
QuickWeb light, identifying 11

R
recovering 126
recovery partition 130
release latches, battery 17
removal/replacement
preliminaries 43
procedures 48
restore security defaults 111
restore the factory settings 107
restoring the hard drive 130
RJ-11 (modem) jack
pin assignments 138
RJ-11 (modem) jack,
identifying 15
RJ-11(modem) jack cable,
illustrated 32
RJ-45 (network) jack
pin assignments 139
RJ-45 (network) jack,
identifying 16
RJ11 modem cable 28
RTC battery
removal 68
spare part number 27, 68
rubber kit
spare part number 35
run-in test 109

S
SATA (Serial Advanced
Technology Attachment) devices
AHCI (Advanced Host
Controller Interface) 110
IDE (Integrated Drive
Electronics) 110
screw Kit
spare part number 35
security cable slot, identifying 16
Security menu
allow reset of HP ProtectTools
security keys 108



always prompt for HP
SpareKey enroliment 108
Automatic DriveLock 108
change password 108
Disk Sanitizer 108
DriveLock 108
HP Sparekey 108
HP Sparekey enroliment 108
password policy 108
set up BIOS administrator
password 108
System IDs 108
user management 108
security, product description 5
serial number label,
location 21, 48
service considerations 43
serviceability, product
description 8
set security level 111
setup utility
Diagnostics menu 109, 115
File menu 99, 107, 113
navigating and
selecting 98, 104, 112
restoring factory
settings 99, 105, 112
Security menu 101, 108, 114
System Configuration
menu 102, 110, 116
SIM
removal 50
spare part number 50
SIM slot, identifying 17
slots
ExpressCard 16
security cable 16
SIM 17
speakers
removal 60
spare part number 28, 60
speakers, identifying 12
specifications
Blu-ray ROM with LightScribe
DVDxR/RW SuperMulti DL
Drive 122
computer 118
display 119, 120

DVD +RW SuperMulti Double-
Layer Drive with
LightScribe 121

DVD-ROM Drive 121

hard drive 120

optical drive 121, 122

system resources 124

start-up test 109
static-shielding materials 47
stringent security 114
switch cover

removal 51

spare part number 23, 51

system board

removal 93

spare part numbers 28, 93

System Configuration

menu 102, 110, 116
system date and time 100, 107
System Diagnostics menu 109
system fan 103, 110, 116
system IDs 108
system information 99, 107, 113
system resources 124

T
thermal material,
replacement 76
tools required 43
top cover
removal 89
spare part number 27, 89
TouchPad
identifying 10
TouchPad indicator,
identifying 10, 11
transporting guidelines 46

u
Unified Extensible Firmware
Interface (UEFI) mode 110
USB connector board
removal 94
spare part number 28, 94
USB legacy
support 98, 103, 104, 110, 112
, 116
USB port
pin assignments 140
USB ports, identifying 15, 16

Vv

vents, identifying 16
Virtualization Technology 110
visual, product description 3

w
webcam
identifying 18
webcam light, identifying 18
Windows applications key,
identifying 13
Windows Backup utility 131, 132
Windows logo key, identifying 13
Windows recovery 129, 132
Windows Vista operating system
DvD 130
wireless antenna,
disconnecting 62, 70
wireless antennas 19
wireless, product description 4
WLAN antennas, identifying 19
WLAN module
removal 69
spare part numbers 26, 69
workstation guidelines 46
WWAN antennas, identifying 19
WWAN module
removal 62
spare part number 62
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